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Legal Information 
The Schneider Electric brand and any registered trademarks of Schneider 
Electric Industries SAS referred to in this guide are the sole property of 
Schneider Electric SA and its subsidiaries. They may not be used for any 
purpose without the owner's permission, given in writing. This guide and its 
content are protected, within the meaning of the French intellectual property code 
(Code de la propriété intellectuelle français, referred to hereafter as "the Code"), 
under the laws of copyright covering texts, drawings and models, as well as by 
trademark law. You agree not to reproduce, other than for your own personal, 
noncommercial use as defined in the Code, all or part of this guide on any 
medium whatsoever without Schneider Electric’s permission, given in writing. 
You also agree not to establish any hypertext links to this guide or its content. 
Schneider Electric does not grant any right or license for the personal and 
noncommercial use of the guide or its content, except for a non-exclusive license 
to consult it on an "as is" basis, at your own risk. All other rights are reserved. 

Electrical equipment should be installed, operated, serviced and maintained only 
by qualified personnel. No responsibility is assumed by Schneider Electric for any 
consequences arising out of the use of this material.  

As standards, specifications and designs change from time to time, please ask 
for confirmation of the information given in this publication.



 
 

 

Safety information 

Important information 
Read these instructions carefully and look at the equipment to become 
familiar with the device before trying to install, operate, service or maintain 
it. The following special messages may appear throughout this manual or 
on the equipment to warn of potential hazards or to call attention to 
information that clarifies or simplifies a procedure. 

The addition of either symbol to a “Danger” or “Warning” safety label indicates 
that an electrical hazard exists which will result in personal injury if the 
instructions are not followed. 

This is the safety alert symbol. It is used to alert you to potential personal injury 
hazards. Obey all safety messages that follow this symbol to avoid possible 
injury or death. 

 DANGER 
DANGER indicates a hazardous situation which, if not avoided, will result in death or 
serious injury. 

 

 WARNING 
WARNING indicates a hazardous situation which, if not avoided, could result in death 
or serious injury. 

 

 CAUTION 
CAUTION indicates a hazardous situation which, if not avoided, could result in minor 
or moderate injury. 

 

NOTICE 
NOTICE is used to address practices not related to physical injury.  

 

Please note 
Electrical equipment should be installed, operated, serviced and maintained only 
by qualified personnel. No responsibility is assumed by Schneider Electric for any 
consequences arising out of the use of this material. 

A qualified person is one who has skills and knowledge related to the 
construction, installation, and operation of electrical equipment and has received 
safety training to recognize and avoid the hazards involved. 
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Safety Precautions 
During installation or use of this software, pay attention to all safety messages 
that occur in the software and that are included in the documentation. The 
following safety messages apply to this software in its entirety. 

 WARNING 
UNINTENDED EQUIPMENT OPERATION 

• Do not use the software for critical control or protection applications where human 
or equipment safety relies on the operation of the control action. 

• Do not use the software to control time-critical functions because communication 
delays can occur between the time a control is initiated and when that action is 
applied. 

• Do not use the software to control remote equipment without securing it with an 
authorized access level, and without including a status object to provide feedback 
about the status of the control operation. 

Failure to follow these instructions can result in death or serious injury. 

 

 WARNING 
INACCURATE DATA RESULTS 

• Do not incorrectly configure the software, as this can lead to incorrect reports 
and/or data results. 

• Do not base your maintenance or service actions solely on messages and 
information displayed by the software. 

• Do not rely solely on software messages and reports to determine if the system is 
functioning correctly or meeting all applicable standards and requirements. 

• Consider the implications of unanticipated transmission delays or failures of 
communications links. 

Failure to follow these instructions can result in death, serious injury, equipment 
damage, or permanent loss of data. 
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About this Document 
This guide is to help Application Engineers, third-party integrators, and other 
qualified personnel to configure and tuning the Power Quality (PQ) Advisor 
module. 

Supporting documentation 
Refer to the following StruxureWare™ Power Monitoring Expert documents: 

• Installation Guide 7EN02-0380-00. 
• User Guide 7EN02-0379-00. 
• Design Guide 7EN42-0118-00 
• Power Quality Advisor Design Guide 7EN42-0132-00 
• Hierarchy Configuration Guide 7EN42-0108-00 
• Web Applications – Help Topics 7EN52-0384-00 
• Power Monitoring Expert 7.2 & 8 Licensing Guide (available on the Power 

Monitoring Expert Exchange Community). 
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Prerequisites 
Competency 

Application Engineers who are responsible for deploying the PQ Advisor module 
must: 

• Be familiar with StruxureWare™ Power Monitoring Expert, StruxureWare 
Power Monitoring, or PowerLogic ION Enterprise software systems. 

• Be familiar with Schneider Electric power meters and circuit breakers. 
• Be familiar with Microsoft Windows operating systems. 
• Be familiar with Microsoft SQL Server. 
• Have basic knowledge of power quality. 
• Understand how PQ Advisor works, as documented in the Power Quality 

Advisor Module Design Guide. 

It is highly recommended that you take the PME PQ Advisor technical training 
from your local or regional training center. 

System Readiness 
The PME system must be fully commissioned before starting the configuration of 
the PQ Advisor module. 
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Power Quality Advisor Overview 
Power Quality Advisor is an optional application module of Power Monitoring 
Expert (PME) software. It presents complex power quality information in a 
simpler form. 

 

 
 

Refer to StruxureWare Power Monitoring Expert Power Quality Advisor Design 
Guide for more information about the PQ Advisor features. 
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Configure the Monitoring Devices 
The PQ Advisor can perform an analysis only when monitoring devices (power 
meters, circuit breakers) have been properly configured to capture power quality 
events and disturbances. This section describes how to: 

• Enable Power Quality Event Detection. 
• Enable Power Quality Disturbance Logging. 
• Enable Time Synchronization. 

Refer to StruxureWare Power Monitoring Expert Power Quality Advisor Design 
Guide for more information about power quality events and disturbances. 

Enable Power Quality Event Detection 
See Appendix A – Meter Support List on page 74 for supported devices. 

Enabling power quality event detection on the supported meters involves:  

• Enabling Sag/Swell detection 
• Enabling Transient detection 

Disturbance direction detection (DDD) is enabled by default if supported. 

Note: The disturbance direction detection (DDD) feature, available on select meters, is 
used to determine if the events are undetermined, internal or external to the system. 
Without DDD, all events will show as undetermined in the PQ Advisor features. 

You can do this by using meter configuration tools (such as ION Setup), or by 
configuring the meter directly. Refer to the meter documentation for more 
information. 

In addition, you can configure ION meters (such as, ION7650, PM8000, etc.), in 
PME Vista. 
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After the power quality events are detected by the meter, they are classified by 
PME Power Quality Event Classification method and stored in PME database as: 

• Interruptions 
• Voltage Sag 
• Voltage Swell 
• Transient Voltage 
• Over voltage 
• Under voltage 

Refer to StruxureWare Power Monitoring Expert Design Guide for more 
information about PME Power Quality Event Classification. 

Enable Power Quality Disturbance Logging 
PQ Advisor consumes the periodical data logs for  

• Voltage Unbalance 
• Current Unbalance 
• Voltage Harmonics 
• Current Harmonics 
• Frequency Variation 
• Flicker 

The supported meters are shown in Appendix A – Meter Support List on page 74. 
They are categorized as: 

• Logged by Default – means the supported measurements are logged by the 
default. For these meters, no additional configuration is required. However, 
for brownfield installations, care must be taken to see if the configuration has 
been modified.  

• Not Logged by Default – the meter measures the value but does not log it. 
You need to enable logging on these meters. 

Choose the Measurement to Log 
The supported measurements and their corresponding register labels are in 
Appendix B – Measurement Support List on page 76. 

Note: For each disturbance category, choose only the appropriate/necessary 
measurements from the supported list to log. Do NOT log all of them – it can cause 
unwanted database growth, and performance issues. 

For example, for Voltage Unbalance, you may find both of the supported 
registers Voltage Unbalance L-L Worst and Voltage Unbalance L-N Worst 
available in a non-ION device. Choose the one which is required by your local 
standards. 

Or, for  Voltage Harmonics, you may find all of the 8 supported registers 
available in a non-ION device. If per-phase analysis is important to the customer 
on this device, choose the 3 per-phase measurements based on your system 
and standards. If per-phase analysis is not important (because of the load, 
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design, or other reasons), choose only one measurement; either THD Voltage L-
L or THD Voltage L-N, which are the averages of the per-phase values. 

Enable the Logging 
To enable the logging for devices categorized as “Not Logged by Default”: 

• Supported measurements are logged by default for most ION meters, so 
configuration is not required.  For some models, where the supported 
measurements are not logged by default, you can configure logging by using 
PME Designer. 

• For non-ION meters, you can use PME Modbus Device Importer to configure 
logging: 

Note: For non-ION devices, PQ Advisor only supports the logged instantaneous values. 
Do NOT log the calculated values (Mean, High, or Low). Leave the Log Interval set to the 
default 900 seconds. 

 

 

Refer to StruxureWare Power Monitoring Expert User Guide for more information 
about using Designer and Modbus Device Importer. 

• For the non-ION meters, especially PM800 (except PM810 without 
PME810LOG), CM3000, and CM4000, configure the on-board logging using 
meter configuration tools. 

Note: 

The PM800 Series devices are supported, except the PM810 without PM810LOG.  
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Flicker 
Flicker is only available when the supported meter has a PQ framework with 
EN50160 evaluation enabled. Refer to the meter documentation for more 
information. 

Once enabled, the flicker measurements are logged in 10-minute intervals by 
default. There is no need to change the logging interval. 

Enable Time Synchronization 
Time synchronization is crucial for: 

• Event clustering (the same event seen by different devices is only counted 
once). 

• Correctly associating the process impact alarms with power quality events. 

The standard synchronization between PME server and devices is adequate for 
enabling PQ Advisor features. 

• For Modbus devices, time synchronization through Modbus is activated by 
default. 

• For all ION protocol devices (e.g. ION7650, PM8000, etc.), the application 
engineer needs to enable this feature. 

Note: High accuracy of time synchronization (such as IRIG-B, etc.), can be used to 
address user requirements, but it is not required for PQ Advisor. 

 
To enable PME time synchronization on an ION device: 

1. Connect to the device using ION Setup. On the Timezone tab for Clock, 
change entry for the CL1 Time Sync Source to ETHERNET - ION. You can 
also do this on the meter front panel. 
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2. In Management Console: 
a. For an Ethernet device, set the Time Synch Ethernet Enabled to Yes in 

the Ethernet Device Configuration. 
 

 
b. For a serial device, set the Time Synch ION Enabled to Yes in the 

Ethernet Gateway Site Configuration. 
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Power Quality Advisor Configuration Overview 
The Power Quality (PQ) Advisor module features are controlled by its feature 
license. Refer to Power Monitoring Expert 7.2 & 8 Licensing Guide on how to 
activate a license. 

Once the PQ Advisor module is licensed, the following features do not require 
specific configuration to work: 

• Power Quality Rating Gadgets 
- PQ Rating Gadget 
- PQ Rating Trend Gadget 

• Power Quality Events Detail Gadgets 
- Power Quality Events Breakdown Gadget 
- Power Quality Events Impact Gadget 
- Power Quality Events Location Gadget 

The features listed below require additional configuration to work, which will be 
described in the following sections 

• PQ Advisor Diagrams 
- PQ Indicator Diagrams1 
- Standardized Equipment Diagrams 

• Power Quality Impact Gadgets and Reports 
- Power Quality Impact Gadget 
- Power Quality Impact Trend Gadget 
- Power Quality Impact Report 

• Power Factor Impact Gadgets 
- Power Factor Impact Gadget 
- Power Factor Impact Trend Gadget 

• Power Quality Analysis Report2 

1 The PQ Indicator Diagrams are pre-configured with default settings. They work 
when you paste a simple framework in the PQ Advisor VIP. 

2 The Power Quality Analysis Report needs additional configuration only when 
the power factor section is enabled. 
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Configure Global Parameters 
You may need to change the global parameters, depending on the requirement 
of the customer’s facility. 

Configure the Nominal Frequency 
The default nominal frequency is 60Hz. To change this: 

1. Go to SQL Server Management Studio, locate the dbo.vCFG_ConfigItems 
view in the ION_Network database, and right-click to select "Edit Top 200 
Rows". 

 
2. Find the Frequency Nominal row. 
3. Set the Value to the appropriate local nominal frequency. 

 

 



Schneider Electric  Power Quality Advisor Module Configuration Guide 

Page 18 CONTROLLED DISTRIBUTION © 2016 Schneider Electric.  All rights reserved. 

Configure PQ Advisor Diagrams 
The following sections describe how to configure the Power Quality (PQ) Advisor 
diagrams: 

• Configure Power Quality Indicator Diagrams 
• Configure the Standardized Equipment Diagrams 
• Optional - Create a Power Quality Advisor Tab in the Web Interface 

Configure Power Quality Indicator Diagrams 
The PQ Indicator Diagrams introduce simple green-yellow-red indicators for the 
most common power quality problems.  

 

The PQ Indicator Diagrams are pre-configured with default settings. Complete 
the following steps to enable the functionality: 

• Paste the Power Quality Advisor Framework 
• Open the Power Quality Indicator Diagrams 

Paste the Power Quality Advisor Framework 
The VIP Frameworks included with the Power Quality Advisor installation get 
data from the PQ Advisor Web Service in order to display values and drive the 
status objects in the PQ Advisor Indicator Vista Diagrams.  

Note:  

The VIP.PQADVISOR ION Service must be running to proceed with the steps below. (The 
service is configured to start automatically.) 

Installing the PQ Advisor framework onto an ION VIP Service other than VIP.PQADVISOR 
is not recommended. 

Installing the PQ Advisor framework onto an ION VIP Service that has existing modules 
that have been put in by a user is not recommended. 
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1. Open Power Monitoring Expert Designer. 
2. Click File > Open. 
3. Click the ‘VIP.PQADVISOR’ node and click OK. 
4. Select the Edit > Paste from framework menu item. 
5. Navigate to the folder containing the PQ Advisor Framework file: 

{root install folder}\config\fmwk\PQ_Advisor 

6. Click the file PQAdvisor_v1.0.0.0.0.fwn and click Open. 
 

Note: Use the most current version of the fwn file available. 

7. In the Paste Summary dialog: 
c. Ignore items with a red checkmark, as these are core modules that 

cannot have two instances in the same VIP. The existing modules will 
work with the new framework being pasted. 

d. In the Source column, select the first list entry with a green checkmark, 
press and hold the Shift key, and then click the green checkmark icon in 
the checkbox on the final entry. This action applies the lock paste 
selection to all of the entries. 
 

 
 

NOTICE 
UNINTENDED DEVICE OPERATION 

• Do not use the lock paste option to overwrite existing destination modules. 
• Only use the lock paste option if you are an advanced user familiar with ION 

architecture. 

Failure to follow these instructions can result in operational differences in 
required modules. 

 

e. In a new PME installation, no modules should be overwritten. In an 
existing PME installation there maybe conflicts and the framework paste 
may try to overwrite existing module; if this occurs double click the 
checkbox again so that it returns to just a checkmark, and note the 
module that created a conflict. 

 

8. Press OK when pasting is complete. 
The Power Quality Advisor framework should now be visible in Designer. 

9. Click Save to complete the process. 
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Open the Power Quality Indicator Diagrams 
The PQ Indicator Diagrams are located under: 

{root install folder}\config\diagrams\ud\PQ_Advisor 

The diagrams start to function once the framework is pasted in the PQ Advisor 
VIP. You can link them to the existing Vista diagrams or use them separately.  

 

Note: When a Power Quality Indicator has no supported device to feed it the required 
data, it should be disabled by following the procedures in the section Disable Unused 
Power Quality Indicators on page 68. 

 

Set the Query Server – Distributed System Only 
When using distributed PME systems, set the query server node for the following 
landing page diagrams: 

• PQAdvisor_LandingPage_24h_V1.0.0.0.0.dgm 

• PQAdvisor_LandingPage_7d_V1.0.0.0.0.dgm 

• PQAdvisor_LandingPage_30d_V1.0.0.0.0.dgm 

• PQAdvisor_LandingPage_12m_V1.0.0.0.0.dgm 
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Configure the Standardized Equipment Diagrams 
The following sections describe how to set up and configure the Standardized 
Equipment Pages. Skip this section if corrective equipment does not exist in the 
system. 

• Configure the Framework for the Equipment Diagrams 
• Configure the Equipment Diagram Detail Pages 
• Configure the Equipment Diagram Group Pages 
• Configure the Equipment Diagram Landing Pages 

Unlike the PQ Advisor Indicator diagrams, the Equipment diagrams are not auto-
functional pages, but rather templates that you use during commissioning to 
provide the user with equipment status displays with the same user experience 
and focus on simplification as the PQ Advisor Indicator pages. 

The equipment diagram elements are: 

• Equipment Diagram Landing Pages 
• Equipment Diagram Grouping Pages 
• Equipment Diagram Detail Pages 

Equipment Diagram Landing Pages 

The Corrective Equipment Status portion of the Power Quality Advisor page is a 
landing page. 
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The Equipment page is also a landing page. 

 

 

Equipment Diagram Grouping Pages 

When you select an element o the Equipment landing page (e.g. Capacitor 
Banks), the grouping page opens. A summary entry for each device (e.g. 
Capacitor Bank) in the system could be configured here. 
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Equipment Diagram Detail Pages 

When you select an element on the Equipment Grouping Page, the equipment 
diagram detail page for that device opens. 

 
The following supported devices currently have template pages available: 

• Capacitor Banks: VarPlus Logic VL6 and VL12 
• Active Harmonic Filters (AHF): Accusine PCS+/PFV+ 
• Uninterruptible Power Supplies (UPS): Galaxy 5000 and 5500 

All Equipment Diagrams are installed in the following location: 

{root install folder}\config\diagrams\ud\Equipment 

http://www.schneider-electric.com/en/product-range/63426-accusine-pcs-/
http://www.schneider-electric.com/en/product-range/63426-accusine-pcs-/
http://www.schneider-electric.com/en/product-range/61898-mge-galaxy-5000/
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Configuration Workflow 

The order of commissioning is the opposite of user workflow. You set up the 
Detail Pages first. Then you create the buttons for each Detail Page on the 
Group Pages. The Landing Pages (both Equipment and PQ Advisor Indicator), 
require no commissioning other than optional customization if required. 

 

 

Configure the Framework for the Equipment Diagrams 
The Equipment Pages require custom configuration of the VIP framework by the 
deploying Application Engineer in order to display aggregated warning/alarm 
indicators found on the PQ Advisor Indicator Landing Pages and on the 
Equipment Landing and Group Pages. 

Note: The VIP.PQADVISOR service must be set up and running with the 
Equipment Status Indicator Framework configured in order to commission the 
Equipment Diagrams. 

The PQ Advisor Framework contains some template OR Logic modules and 
simple instructions on configuring the VIP to work with the Equipment Pages: 

1. Open the VIP.PQADVISOR framework in Designer. 
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2. Open the grouping folder labeled Equipment. 
 

 
 
The Equipment folder contains the following: 
 

 
 
Summary Section: 
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3. Capacitor Bank Section: 
 

 
Active Harmonic Filters Section: 
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4. The UPS Section: 
 

 
 

Configure Device Count 
1. Right-click the module labeled DEVICE COUNTS to open the ION Module 

Setup dialog. 
2. Double-click any of the ‘Formula’ Setup Registers to modify their value. The 

value entered represents the number of devices of corresponding type listed 
directly to the right in the Output Registers list. 
 

 

3. Repeat Step 4 until there is a device count number for each of the listed 
devices. 
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Configure Equipment Status 
1. Start with the set up of the capacitor bank by duplicating the template module 

labeled Cap Bank Group Item: TEMPLATE (or by creating a new AND/OR 
module). 
 

 
 

2. Right-click the new module and make the following modifications: 
a. Set the mode of operation to OR. 
b. Enter the name of the capacitor bank device in the Custom Label field. 

 

 
3. Link the input of the new module to a device alarm status output by 

performing the following steps: 
a. Click the ION button on the toolbar to open the Create Link dialog. 
b. Click the desired device, Alarms under Managers, Low Current Alarm 

under Modules, and Low Current Alarm under Output Registers.  
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c. Click OK. 
 

 

 
d. The cursor should now appear with a circle; click the input of the module 

and select NEW Source. 
 

 
 

4. Repeat Step 3 until each of the capacitor bank’s desired alarm status is 
connected to the module. 
By doing this, the output of the module outputs a ‘1’ (High) state if any of the 
connected alarm states are activated. 

5. Link the output of the new module to the input of the module labeled Cap 
Bank Landing Page. 
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6. Repeat Steps 1-5 for each capacitor bank in the system. 
7. Remove the link between the output of the template module and the input of 

the Landing Page module: 
a. Right-click the input of the Landing Page module. 
b. In the resulting window select the appropriate input. 
c. Click the Unlink button. 

8. Repeat Steps 1-7 for the Active Harmonic Filter and UPS device frameworks 
until each desired corrective equipment device in the system is connected. 

9. Save the modified framework. 
 

Note: The outputs of the modules configured for the individual devices drive the 
Equipment Group Page indicators, and the outputs of the Landing Page modules drive the 
Landing Page Indicators on both the Equipment Pages and PQ Advisor Indicator pages. 

 

Configure the Equipment Diagram Detail Pages 
Each individual piece of equipment in the system could have its own detail page. 
These diagrams connect directly to the devices and do not have any interaction 
with the PQ Advisor VIP service. 
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To set up any of the detail pages using the provided template diagrams, perform 
the following steps: 

1. In Windows Explorer, open the folder location that contains the DetailPage 
template for one of the Equipment (UPS, Capacitor bank or Harmonic filter). 
 

 
2. Highlight the template that will be used and copy it by pressing Ctrl+C and 

paste it using Ctrl+V. 
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3. When the file is pasted, it is enabled for editing. Choose a new name for the 
diagram file; preferably one that is easily associated with the particular 
device of interest. 

 
NOTE: Take care not to overwrite the original template file by ensuring that the new file 
has a new and distinct file name. 

4. Open the PME Vista application and ensure that the toolbox is enabled. 
5. Open the new file that was created in steps 1-4 by selecting File > Open and 

navigating to the containing folder in the dialog. 
6. When the diagram opens, right-click anywhere on the background and select 

Properties on the menu. 
 

 
7. In the subsequent dialog, select the Node tab. 

 

 
 

8. On the Node tab, select Custom and then click Select to open the Select 
Node dialog. 

9. Select the node name of the equipment for which the diagram was created, 
and click OK. 
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10. Click OK on the properties dialog, and click Save in Vista. 
 

Provided the correct device was selected as the parent node of the page 
(that is, that the device mapping is correct), all the fields and indicators on 
the page should populate and be ready for use.  
 
Verify that the device selected is the correct type for the template being used, 
and that the device is configured correctly. 

Once the page has been linked to the node, there are a few manual steps 
that should be completed to customize the page: 
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11. Customize the page as per the graphic above: 
a. Update the page header to include the unique name of the device. 
b. Change the picture of the device from the sample image to a custom 

image, such as a standard image or an actual picture of the device. 
c. Update the device model name to be more specific. 

12. As a final step, click the folder icon in the Overview section to view the 
default diagram of the device. Verify that the correct default diagram 
appears, and that the values and status shown match what appears on the 
detail page. 

 
13. Repeat step 1-12 for other equipment. 

 

Configure the Equipment Diagram Group Pages 
Group Pages allow for viewing of multiple devices of a particular type from a 
single location. 

 

This is made possible by creating and customizing "Buttons" that consist of 
grouping, numeric, text, and status objects arranged to represent a clickable 
overview of a single device. 



Power Quality Advisor Module Configuration Guide  Schneider Electric 

© 2016 Schneider Electric.  All rights reserved. CONTROLLED DISTRIBUTION Page 35 

 

 

Group Pages Set Up and Scaling 
Before the Group Page for a particular device type can be populated, the logical 
organization of the device grouping must be reviewed, and multiple Group Pages 
need to be created if necessary. 

If there are less than eight devices of the Group Page type, then proceed to the 
Group Page Buttons Setup and Detail Page Association on page 41. If there are 
more than eight, more Group Page diagrams will have to be created. These new 
pages will be linked as tabs from the main device type Group Page. 

Device Scaling 
The first step is to determine how many diagrams will be required by counting the 
number of devices of the type in question. A single Group Page diagram has 
eight Button positions, so there will need to be a Group Page diagram for each 
eight devices and portion thereof. For example, if the system contains ten 
capacitor banks (each with its own Detail Page diagram), then there will need to 
be two Group Page diagrams; one page with eight buttons, one page with two. 

Alternately, a different organizational scheme can be incorporated by creating a 
Group Page for each logical grouping of devices. For example, a separate Group 
Page can be created for each production line in a facility, thus allowing the user 
to conveniently check the active harmonic filters that are present for a production 
line that is experiencing problems. 

Another option is to create Group Pages for different buildings or areas within a 
facility; in the end it is up to the deploying Application Engineer to determine the 
solution which makes the most sense for the user's application. 

Group Scaling 
Each Group Page has space for six tabs, therefore, if there are more than six 
Group Pages required for a single device type, they need to be arranged into 
sub-types on the Landing page level. For example, if there were twelve Group 
Pages for active harmonic filters, they need to be split into two logical categories 
and treated separately on the Landing Page level.  

For the purpose of this set up guide, assume that there are only six or less Group 
Pages required in the steps outlined below. 
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Group Page Logical Set Up 
With the number of Group Pages required in mind, complete the following 
preliminary setup steps: 

Set Up the Group Page Files 
1. In Windows Explorer, open the folder location that contains the Group Pages. 
2. Highlight the template that will be used. Copy it by pressing Ctrl+C and paste 

it using Ctrl+V. 
3. When the file is pasted, the file name opens for editing. 

 

 

Choose a new name for the diagram file; preferably one that reflects how the 
Group Pages will be organized. 

Note that the original file (the one that contains the word "All" or "Pg1" in the 
filename) will be the main Group Page that is linked to/from the Equipment 
landing page. For example, if one were creating an active harmonic filter 
Group Page for each floor of a facility the filenames would be as follows: 

a. Equipment_GroupPage__AHFAll_V1.0.0.0.0.dgm (default filename for 
the first floor) 

b. Equipment_GroupPage_ AHF_Floor2_V1.0.0.0.0.dgm 
c. Equipment_GroupPage__AHF_Floor3_V1.0.0.0.0.dgm 

And so on. 

Note: Use the most current version of the dgm file available. 

4. Press Enter to save the file name. 
5. Repeat steps 2-3 until you create all of the required files. 
 



Power Quality Advisor Module Configuration Guide  Schneider Electric 

© 2016 Schneider Electric.  All rights reserved. CONTROLLED DISTRIBUTION Page 37 

Set up Tabs in the First Group Page 
1. Open PME Vista and ensure that the Toolbox is enabled. 
2. Open the first logical Group Page file that is to be set up by selecting File > 

Open from the menu bar and navigating to the containing folder in the dialog. 
3. Select the tab text (the green text Default Group in new installations) and 

press Ctrl+C to copy it. 
 

 
 

4. Press Ctrl+V to paste up to six text boxes - one for each Group Page. 
5. Arrange the text boxes evenly along the tab line in up to five additional "tab" 

positions. 
6. Change the text color for each of the pasted text boxes (but not the original) 

to black: 
a. Right-click the text box to open the Text Box Configuration dialog. 
b. Click the Text tab. 
c. Select Custom and click the Font button to open the Font dialog. 
d. Select Black from the Color dropdown menu and click OK. 
e. Click OK on the configuration dialog to complete the change. 
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7. Place a new Grouping Object over top of each new text box. 
 

 

 

8. Change the shape of each new grouping object by left-clicking the object and 
dragging the black tabs that appear. 
The objects will be what the user will click to navigate to other tabs; they 
should therefore cover the text underneath, and should not overlap. 

9. Make each new grouping object link to the Group Page diagram referenced 
by the text underneath it. 
a. Right-click the grouping to open the Grouping Object Configuration 

dialog. 
b. Select the Action tab. 



Power Quality Advisor Module Configuration Guide  Schneider Electric 

© 2016 Schneider Electric.  All rights reserved. CONTROLLED DISTRIBUTION Page 39 

c. Select Open User Diagram and click the Browse button to open the 
Choose sub-diagram dialog. 
 

 

 

10. Make each new grouping object appear transparent to show the text 
underneath it. 
a. Right-click the grouping to open the configuration dialog. 
b. Select the Display tab. 
c. Select None. 
d. Click OK in the configuration dialog to complete the change. 

 

 

 

11. Hold down the left mouse button and draw a marquee around all of the tab 
(text box and grouping) objects. 

12. Press Ctrl+C to copy the objects. 
13. Save and close the diagram. 
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Set Up Tabs in Subsequent Group Pages 
1. Open the next Group Page diagram by selecting File > Open from the menu 

bar and navigating to the containing folder in the dialog. 
2. Delete any existing text box objects in the tab area by selecting them and 

pressing Delete. 
3. Press Ctrl+V to paste the tab objects from the previous Group Page 

diagram. 
4. Change the color of the text in the text box that represents the first Group 

Page to black (see "Setting up Tabs in the First Group Page', Step 6). 
5. Add a new grouping object over top of the text that represents the first Group 

Page, modify it to be transparent, and link it  to the first Group Page diagram 
file (see "Setting up Tabs in the First Group Page', Steps 8-10 ). 

6. Delete the grouping object in the tab area that links to the current Group 
Page by selecting it and pressing Delete. 

7. Change the color of the text in the text box that represents the current Group 
Page to green. 

8. Change the background image of the diagram to one that has highlighting on 
the correct portion of the tab area: 
a. Right-click any unpopulated space on the diagram area and select 

Properties on the menu. 
b. Select the Image tab in the Configuration dialog. 
c. Select Custom Image and click Browse. 
d. In the resulting, navigate to the following location: 

…\config\diagrams\images\Equipment_Diagrams\Backg
rounds 

e. Select the correct background image. 
Each Equipment diagram background image included in this installation 
is the same, except for the position of a green highlight in the tab area. 
The filename of the background image indicates where the green 
highlight is located. For example, 
"PQEquip_Lvl1BG_Pos2_V1.0.0.0.0.bmp" has a highlight in the second 
position from the left, indicated by the "Pos2" text in the filename. 
Double-click the file to complete the selection. 

Note: Use the most current version of the bmp file available. 

f. Click OK to complete the change and to close the configuration dialog. 
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9. Repeat steps 1-8 until all Group Pages have the required tabs. 

Group Page Buttons Set Up and Detail Page 
Association 
The following steps outline how to set up a Group page with custom buttons for 
each device that has an associated Detail Page: 

1. Open Vista and ensure the Toolbox is enabled. 
2. Open the Group Page file that is to be set up by selecting File > Open from 

the menu bar and navigating to the containing folder in the dialog. 
3. Hold down the left mouse button and draw a marquee around the template 

button in the top left position of the page space, selecting all objects 
contained within. 

4. Press Ctrl+C to copy the button items. 
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5. Press Ctrl+V to paste up to seven additional buttons (for a total of eight on 
the page); one for each device with a Detail Page. 
 

 
 

6. Link an indicator (status) object to its corresponding ION module in the PQ 
Advisor Equipment VIP Framework: 
a. Right-click the indicator (status) object. 
b. Navigate to the correct module output by selecting the following in the 

Create Link dialog: 
i. Node: VIP.PQADVISOR. 
ii. Managers: And/OR Modules. 
iii. Modules: the AND/OR module that was set up for the 

corresponding device in the Equipment Status Indicator 
Framework step. 

iv. Output registers: (module designator) Result. 

https://vicwiki.nam.gad.schneider-electric.com/display/PDG/VIP+Frameworks#VIPFrameworks-EquipmentFramework
https://vicwiki.nam.gad.schneider-electric.com/display/PDG/VIP+Frameworks#VIPFrameworks-EquipmentFramework
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7. Repeat step 6 for each indicator object on the page. 
8. Link the numeric objects within the button to the corresponding outputs on 

the device. 
a. Right-click the numeric object. 
b. Navigate to the correct module output by selecting the following in the 

'Create Link' dialog; start by selecting the device in the 'Node' section 
and navigating to the desired numeric output. 

9. Repeat step 8 for each numeric object on the page. 
10. Link the button background to the appropriate Detail Page: 

a. Right-click the button (grouping object) area where there is no other 
object (such as numeric or indicator). 

b. Select the Action tab on the configuration dialog.  
c. Select Open User Diagram and click Browse. 
d. In the resulting window, navigate to the Detail diagram file. 
e. Click OK on the configuration dialog to complete the change. 
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11. Repeat step 10 for each button (Grouping Object) on the page. 
12. Repeat this process for each (corrective) device type in the system. 

The Group Page should now be configured. 

13. Repeat this process for any other Group Page diagrams in the system. 

Group Button Measurement Linking 
The measurements displayed on the Group Page buttons are linked to the device 
measurements by navigating to the appropriate measurement in the numeric 
object configuration window. To help the deploying Application Engineer, these 
links are listed in more detail below along with the ION Handle: 

See the section called “How to Modify Indicators” in the Appendix called “How to 
Modify Power Quality Advisor Vista Diagrams” for instructions on how to link to 
ION Handles. 

VarPlus Logic Capacitor Bank Button Measurement Display 

Button Label Measurement Label in 
Device 

ION Handle 

Power Factor - Target Target Cos Phi 01 0x8502E01 

Power Factor - Measured Power Factor Total 0x8803701 
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Accusine PCS+  Active Harmonic Filter Button Measurement Display 

Button Label Measurement Label in 
Device 

ION Handle 

Total Load Current - A Load Current A Total 0x8100001 

Total Load Current - B Load Current B Total 0x8100002 

Total Load Current - C Load Current C Total 0x8100003 

Load Harmonic - A Load Harmonics Current A 0x810001B 

Load Harmonic - B Load Harmonics Current B 0x810001C 

Load Harmonic - C Load Harmonics Current C 0x810001D 
 

Galaxy 5500 UPS Button Measurement Display 

Button Label Manager Module Output Register ION Handle 
Time Remaining Diagnostics2 Backup Time Battery Time 

Remaining 0xb300002 

Battery Voltage Voltages Voltage Battery DC Voltage 0xc000018 

Loading Power 
Factors Power Factor Total Output Percent 

Load 0xb200001 

 

Configure the Equipment Diagram Landing Pages 
The Landing Pages are the last to be configured in the Equipment Page setup. 

 

The indicators (Status Objects) on the Landing Pages are linked to the output of 
the respective Equipment Landing Page ION Module in the Equipment Status 
Indicator Framework of the VIP.PQADVISOR service. 
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The Equipment Counts (Numeric Objects) are linked to the 'DEVICE COUNTS' 
ION Arithmetic Module in the Equipment Status Indicator Framework. The 
number of devices of each category within the system needs to be entered into 
the Setup Registers of the module. 

Link the button background to the appropriate Group Page: 

1. Right-click the button (grouping object) area anywhere that there is no other 
object (such as numeric or indicator). 

2. Select the Action tab on the Configuration dialog.  
3. Select Open User Diagram and click Browse. 
4. In the resulting window, navigate to the Group diagram file. 
5. Click OK on the Configuration dialog to complete the change. 
6. Save the diagram. 

Customization might be needed under the following circumstances: 

• There are more than six Group Pages (i.e. more than 48 devices) for a 
particular device. 

• The customer's application demands multiple Landing Pages with custom 
groups of device types. An example of this is pre-configured on default 
Landing Page; there is a tab for all devices and a tab for corrective devices 
only. 

When customization is required, follow the steps in this section for adding 
additional pages/tabs and additional buttons. Note that the background images 
used for the Group Pages are the same as those used in the Landing Pages. 

Optional - Create a Power Quality Advisor Tab in the Web 
Interface 

An optional step is to create a tab in the Web Applications interface to view the 
PQ Advisor Vista diagrams. 

 

To do this: 

1. Navigate to the following file: 
{root install 
folder}\Applications\ApplicationFramework\Framework
.xml 

2. Right click the file and select Edit. 
3. Scroll to the place in the file with the following lines: 

    </Application> 
  </Applications> 

4. Between the two lines shown in step 3 above, copy the following snippet of 
XML code: 
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    <Application id="3a0163ba-c26d-4b79-a846-9e62961ddced" 
name="Advisor" requiredPrivilege="WebReach.AccessApplication" 
buttonContents="" description="PQAdvisorVistaDiagram_Description" 
displayName="PQ ADVISOR" 
resourcesClassName="UI.ApplicationFramework.Resx.ApplicationFrameworkRe
sources, ApplicationFramework, Version=1.0.0.0" securityLevel="0"> 
      <ApplicationSpecificPanelButtons> 
      </ApplicationSpecificPanelButtons> 
      <Libraries> 
        <Library className="LibraryPanelItem3" /> 
      </Libraries> 
      <OptionsButtonControls> 
      </OptionsButtonControls> 
      <SetupControls> 
        <SetupItem SetupControlId="b29ceb39-4cd8-4077-9c7c-
4c6287ac5b64" /> 
        <SetupItem SetupControlId="2600efb2-955a-4fef-9895-
c8e716325656" /> 
        <SetupItem SetupControlId="63c71c83-3d88-4d2f-a6eb-
db9a1b0f3989" /> 
      </SetupControls> 
      <Settings> 
        <Setting name="Url">/ion/default.aspx?dgm=x-
pml:/diagrams/ud/PQ_Advisor/PQAdvisor_LandingPage_7d_V1.0.0.0.0.dgm</Se
tting> 
      </Settings> 
    </Application> 

Note: Use the most current version of the dgm file available. 

5. If the Web Application interface is opened, reload the page. 
6. Verify the new selection appears and that the PQ Advisor indicator diagrams 

are loaded when it is selected. 
 
Note: The System Technical Note titled How Can I Modify the StruxureWare Power 
Monitoring Expert Web User Interface and Add Web Content 
(https://exchangecommunity.schneider-electric.com/message/67646#67646), contains 
more details on modifying the Web Applications User Interface. 
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Configure Power Quality Impact Gadgets and Report 
The Power Quality Impact Gadgets and Reports associate PQ events with 
process impact alarms within a given process / production line, and applies a flat 
rate cost estimate to the duration of the process impact alarm. 

The following sections describe the configuration steps to make the Power 
Quality Impact Gadgets work: 

• Acquire Process Impact Signals 
• Setup Process Impact Alarms 
• Setup Power Quality Groups 

Acquire Process Impact Signals 
A process impact alarm is designed to be created on:  

• An electrical value (e.g. current, voltage, power, etc.) from a power device. In 
this way PME detects the process impact independently (for example, based 
on a current drop). 

• A process impact signal from another system or equipment. The process 
impact signals can be: 

- Hard wired signals from the process. The signal can be from the 
process PLC, motor VSD, etc. It can be hard wired to a digital input 
or an analog input of the meter which monitors the corresponding 
load (requires AI/DI capability on the meter). The signal can also be 
hard wired to a dedicated PLC, which can then be connected into 
PME as a Modbus device. 

- OPC tags from the process. PME (working as OPC client) acquires 
the process impact signals from process SCADA system (working as 
OPC server) via OPC. 

 

Note: If signals from multiple processes are connected to a single device (for example, 
process A and process B signals on a PLC, power meter or OPC connection), then logical 
devices must be defined to represent each process, in order to be used in the power 
quality group definition. 

To acquire the process impact signals (if PME is not detecting the process 
impact independently), the following tasks may be required to accomplish the 
work: 

• Using meter I/Os 
• Using third-party Modbus device in PME 
• Using PME as an OPC client 
• Using PME Logical Device 

Refer to PME documentation for more information. 
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Set Up Process Impact Alarms 
Once the process impact signals are connected into the PME system, or PME is 
set up to detect the process impact independently, process impact alarms need 
to be set up. To do this: 

1. Launch Alarm Configuration from Management Console, or from the 
Alarm tab in the web interface. 
 

 
 

2. Select Add Alarm Rule. 
3. In the User Defined section. Select Analog Measurement if the alarm is 

based on an analog value. Select Digital Measurement if the alarm is based 
on a digital value. 

4. Select the Measurement that will be used to determine a process impact 
event (e.g. Current Avg if using the current drops to signify the process 
impact, or Equipment State if the process impact signal is mapped to this 
measurement for the Logical Device created for the process) 

5. In the Alarm Type field, enter Process Impact Alarm. 
 

Note: The string “Process Impact Alarm” is the only flag that the Power Quality Impact 
report and gadgets looks for. 

 

 
 

6. Configure the thresholds for when the alarm will go ON and when the alarm 
will go OFF. 
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7. Configure the Pickup Delay and Dropout Delay: 
The alarm will go ON if the threshold has been exceeded for longer, in 
seconds, than the “Pickup Delay” value. 

The alarm will go OFF if the value is below the threshold for longer, in 
seconds, than the “Dropout Delay” value. 

8. Configure the Priority. Use a number less than 64 to prevent the alarm from 
appearing in the PME Alarm Viewer. 

9. Set the Polling Interval. The recommendation is 5 seconds. 
10. Select the Source for the alarm rule. If a Logical Devices is created to 

represents a process, select the logical device. 
11. Give the Alarm rule a name. 

 
12. Click Finish. 

 

Set Up Power Quality Groups 
The Power Quality Groups are defined per process (for example, a production 
line), so that only the power quality events captured by the meter which relate to 
the particular process are considered in the impact analysis. 
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Power Quality Groups must be defined or the Power Quality Impact gadgets and 
Report will not function. 

The incomer meters defined in the Power Quality Groups are also used for the 
Power Factor section of the Power Quality Analysis Report. 

Power Quality Group Definition 
Power Quality Group are defined in the PowerQualityGroups.csv file 
which is located under the folder: 

{root install folder}\Applications\PowerQuality\ 

The format of the comma delimited file is as follows: 

<Power Quality Group Name>,<Incomer Meter>,<Feeder 
Meter>,<Load Meter>,<Rate> 

Where: 

• Power Quality Group Name: the name for the group (target process). It is 
used for selecting the group in Power Quality Impact gadgets and report. 

• Incomer meter: the meter monitors the incomer. It typically has the PQ 
event detection capability. The event it captures will be used in the analysis. 

• Feeder Meter: the meter between the incomer meter and the load meter 
(could be multiple). The PQ events it captures can potentially impact the 
process at its downstream. If a feeder meter does not support PQ event 
detection, then there is no need to include it in the definition. See the 
examples in next section. 

• Load Meter: contains the Process Impact Alarms. The Power Quality Impact 
Gadgets and Report will not work if the load meters are not defined for the 
Power Quality Groups. It can be a logical device if the Process Impact Alarm 
is defined on a logical device. See Setup Process Impact Alarms on page 49 
for more information. The load meter typically doesn’t have PQ event 
detection capability.  

• Rate: The flat hourly rate for the cost impact calculation 

Notes: 

The file structure only allows one incomer meter, one feeder meter and one load meter 
per row. If, for a category, more than one meter needs to be included, define them in 
multiple lines with the same group name. 

The file structure allows one rate per group; define it only in the first row of the group. 

The PQ events captured by the meters in a Power Quality Group will be clustered before 
associating with the Process Impact Alarms, so that the same event seen by different 
meters are counted only once. 

Only the PQ events captured by the incomer meter and feeder meter are considered in 
the analysis. If the load meter supports PQ event detection, and you want to include the 
events it detects into the analysis, you need to define it as a feeder meter as well. See the 
examples in next section. 
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The incomer meters defined are also used by the Power Factor section of the Power 
Quality Analysis Report to determine the incomer meters in the system. See the examples 
in next section. 

 

Edit PowerQualityGroup.csv File 
Note: Before editing the PowerQualityGroups.csv file, make sure you 
understand the relationship between the power metering system and the process of the 
customer’s facility. 

To edit the PowerQualityGroups.csv file: 

1. Identify the System Name of a device, go to Management Console, select  
System Name in the Column Selector to add System Name to the display: 

 

 

Note: 

Only the device system names are acceptable.  

 

2. Edit the file in Excel, Notepad or other text editor. For each Power Quality 
Group: 

a. In column B, list all related incomer meters that can detect PQ events for 
the group. Use multiple rows if there is more than one incomer meter. 

b. In column C, list all related feeder meters that can detect PQ events for 
the group. Use multiple rows if there is more than one feeder meter. 

c. In column D, list all related load meters on which the Process Impact 
Alarms are configured for the group. Use multiple rows if there is more 
than one load meter. 

d. Repeat the group name in column A for each row. 
e. Specify the rate in column E for only the first row for the group. 
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3. Repeat step 2 for each Power Quality Group. 

4. Save the file and keep the format as .csv. 

Notes: 

The list separators for the .csv are “,” for most regions, and “;” for several European 
countries. The list separators will be detected from the culture settings and used by the 
import/export exe. 

The rate under culture settings, other than English (en-XX), needs to be enclosed in 
double quotes. For example, for Spain (es-ES), if the rate 123.456.789,0 is represented, it 
is input as "123.456.789,0".  

 

Example 1: 

Take the metering layout in the image on page 50 as an example, the definition  
contains the following: 

 

 

Example 2: 

In a more complicated example: 
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The file contains the following: 

 

Example 3 

As explained in the previous section, in addition to Example 2, if the feeder 
meters do not have PQ event detection capability, there is no need to define 
them. (There is no effect if they are defined.)  

 

Example 4 

As explained in the previous section, in addition to Example 3, if the Process 
Impact Alarm for the “Process A” is defined only under “Load.meter2”, then 
“Load.meter2” is the only meter that needs to be defined for the “Process A”. 
(There is no effect if other load meters are included.) 

 

Example 5 

As explained in the previous section, in addition to Example 4, if the 
“Load.meter3” can detect sag/swell, and you want the event it captures to be 
included the analysis, you need to duplicate it as a feeder meter: 
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Example 6 

The incomer meters defined in the Power Quality Groups are also used for the 
Power Factor section of the Power Quality Analysis Report. 

If the customer does not require the Power Quality Impact feature, and only 
wants to enable the Power Factor section of the Power Quality Analysis Report,  
the file can be created as: 

  

 

Import / Export Power Quality Group Definition 
The tool PQGroupConfig.exe is used to import / export the Power Quality Group 
definition in the PowerQualityGroups.csv file. It is located under the 
folder: 
{root install folder}\Applications\bin 

To import the definition, run the command line: 

PQGroupConfig.exe import "<filepath>\<filename>" 

 

To export the definition, run the command line: 

PQGroupConfig.exe export "<filepath>\<filename>" 
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Configure Power Factor Impact Gadgets 
The Power Factor Impact Gadgets provide a clear visual indication of the impact 
of poor power factor on your energy bill.  

Notes:  

The Power Factor Impact Gadgets only work for billing periods that start on the first day of 
the month. Billing periods that do not start on the 1st (for example, the 20th) are not 
supported.  

The Viewing Period for the Power Factor Impact Gadget should be set to This Month or 
Last Month. The gadget does not show meaningful information if you set the Viewing 
Period to another value. 

The Aggregation Period for the Power Factor Impact Trend Gadget should be set to By 
Month. The gadget does not show meaningful information if you set the Aggregation 
Period to another value. 

 

The calculated surcharge is based on the rate file defined for the PME Rate 
Engine. Creating or modifying the rate files requires knowledge of the PME Rate 
Engine. To learn about the PME Rate Engine, refer to PME Billing Module 
Toolkit: https://exchangecommunity.schneider-electric.com/docs/DOC-8707 

The following sections describe the configuration steps to make the Power Factor 
Impact Gadgets work: 

• Setup the Power Factor Impact Rate File 
• Setup the Incomer Meters in the Hierarchy 

Set Up the Power Factor Impact Rate File 
There are four sample rate files based on different calculation methods that are 
generally used by utilities for power factor rate penalties: 

• Power Factor Impact - Active Energy Billing with PF 
Adjustment Option 1.xml 

• Power Factor Impact - Active Energy Billing with PF 
Adjustment Option 2.xml 

• Power Factor Impact - Apparent Energy Billing.xml 

• Power Factor Impact - Reactive Energy Billing.xml 

The rate file Power Factor Impact Rate.xml is active by default. It 
includes the same calculation as the first sample file. See Appendix C – Power 
Factor Rate File Calculation on page 78 for the calculations of the sample rate 
files. 

The files are located under the folder: 

{root install folder}\config\reports\billing 
report\ratelibrary 

To set up the Power Factor Impact rate file: 

1. Consult with the customer to see how the power factor penalties are 
calculated by the utility provider, including the power factor target under 

https://exchangecommunity.schneider-electric.com/docs/DOC-8707
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which penalty will be charged. 
2. Choose the sample file in which the power factor penalty calculation is the 

closest to customer’s utility contract. 
3. Copy the selected rate file to the file name "Power Factor Impact 

Rate.xml" 
4. modify the file to have the same power factor penalty calculation with 

customer’s utility contract. To learn how to modify the rate files, please refer 
to the PME Billing Module Toolkit as mentioned above.  

5. Set the target to be shown in the gadgets.  
a. Find PF target value by searching for "<Name>PF_target</Name>" 
b. Modify the value for the Formula accordingly. 

 

 
 

6. Save the file. 

 

Set Up the Incomer Meters in the Hierarchy 
The PME rate engine only works with a hierarchy node. Therefore, you need to 
add the meters which are subjected to the penalty to a hierarchy. You can do this 
with the default hierarchy, a custom hierarchy, or virtual meters.  

The gadgets only work on a single node. If more than one physical meter needs 
to be defined (e.g. dual incomer from same utility), add the meters to a single 
node in the hierarchy, or add meters to a single virtual meter. 

For example, to add the dual incomer meters as a virtual meter: 

1. Launch Hierarchy Manager from Management Console or navigate to 
http://<ServerName>/hierarchymanager in a web browser. 
 

2. Click the Virtual Meter tab and click Add. 
 

 

3. Choose a name for the virtual meter, for example Main_Incomers. 
4. Click Add and select a meter to add to the Virtual Meter. Repeat until all the 

you add all of the meters that incur PF penalties. 
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Once the hierarchy node is defined, it can be selected in the Power Factor 
Impact Gadgets. 
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Configure Power Quality Analysis Report 
The Power Quality Analysis Report does not need configuration to work, unless 
you want to include output for the Power Factor section in the report.  

The Power Factor section reports the power factor information for the incomer 
meters in the system. The report retrieves the incomer meter defination from the 
Power Quality Group defination. See Set Up Power Quality Groups on page 50 
for more information on how to define the incomer meters. 

Alternatively, the Power Factor section can be toggled off when generating the 
report. 
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Set Up Power Quality Advisor Dashboards and 
Reports 

This section describes best practices when using PQ Advisor dashboards and 
reports. 

Set Up Power Quality Advisor Dashboards 
PQ Advisor gadgets are grouped into two groups in PME Dashboards: 

• Power Quality Overview 
- Power Quality Impact 
- Power Quality Impact Trend 
- Power Factor Impact 
- Power Factor Impact Trend 
- Power Quality Rating 
- Power Quality Rating Trend 

• Power Quality Details 
- Power Quality Events Breakdown 
- Power Quality Events Impact 
- Power Quality Events Location 

 

Set Up Power Quality Overview Dashboards 
The following image is an example of a Power Quality Overview dashboard. 
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Gadget Viewing Period 
When displaying each gadget with its trending gadget, the aggregation period of 
each bar in the trending gadget should match the viewing period of the non-
trending gadget. Otherwise, they are not comparable.  

For example, if the non-trending gadget is set to be monthly, 

 

 

the corresponding trending gadget should be set to a time range of  Last 12 
Months, and an aggregation of By Month. 

 

Notes: 

Specifically for the Power Factor Impact Gadgets: 

The Viewing Period for the Power Factor Impact Gadget should be set to This Month or 
Last Month. The gadget does not show meaningful information if you set the Viewing 
Period to another value. 

The Aggregation Period for the Power Factor Impact Trend Gadget should be set to By 
Month. The gadget does not show meaningful information if you set the Aggregation 
Period to another value. 

 

Set Up Power Quality Detail Dashboards 
The following image is an example of the Power Quality Detail dashboard. (Three 
regular Trend charts for Power Factor, Harmonics, and Unbalance are combined 
in this dashboard.) 
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Generate Power Quality Advisor Reports 
The following PQ Advisor Reports are available: 

• Power Quality Analysis Report 
• Power Quality Impact Report 

Note: When you generate the Power Quality Advisor reports, a reporting period longer 
than 12 months is not supported. Use multiple yearly reports instead. 

 

 



Power Quality Advisor Module Configuration Guide  Schneider Electric 

© 2016 Schneider Electric.  All rights reserved. CONTROLLED DISTRIBUTION Page 63 

Fine-Tune Power Quality Advisor 
Fine-tuning Power Quality Advisor is very important during commissioning to 
obtain useful power quality views. It depends heavily on customer requirements, 
power system design, power meters used in the system, and also on the power 
quality condition of the customer’s facility.  

This section describes the following fine-tuning procedures: 

• Change Device Inclusion and Exclusion for the Analysis 
• Change Power Quality Indicator Thresholds 
• Disable Unused Power Quality Indicators 

Change Device Inclusion and Exclusion for the Analysis 
You can include or exclude certain meters for power quality assessment by PQ 
Advisor. For example, this capability is useful when you want to include only 
meters which are critical, or to exclude spare meters, etc. Also, for performance 
reasons, it is important to exclude unnecessary meters. 

You can include or exclude the following Power Quality Event types: 

• Interruptions 
• Voltage Sags 
• Voltage Swells 
• Transient Voltage 
• Over Voltage 
• Under Voltage 

And you include or exclude the following Power Quality Disturbance types: 

• Voltage Unbalance 
• Current Unbalance 
• Voltage Harmonics 
• Current Harmonics 
• Frequency Variation 
• Flicker 

Each PQ event or disturbance has an inclusion list and an exclusion list, and the 
following logic applies to both lists: 

1. The inclusion list is processed first: 
a. If the inclusion list is empty, assume that ALL sources in the system are 

included. This means all sources in the sources table. 
b. If the inclusion list is not empty, use only sources that exist in the 

inclusion list. If a source in the inclusion list does not exist in the sources 
table, do not add it to the list. 

2. The exclusion list is processed last: 
a. From the source list obtained in step 1, remove any source that appears 

in the exclusion list. 
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The following features in the PQ Advisor module which are affected by the 
inclusion and exclusion lists: 

• PQ Indicator Diagrams 
• PQ Rating Gadget 
• PQ Rating Trend Gadget 
• Power Quality Events Breakdown Gadget 
• Power Quality Events Impact Gadget 
• Power Quality Events Location Gadget 
• Power Quality Analysis Report – for all sections except the Power Factor 

section 

Note:  

These lists do not define: 
- Devices considered by the Power Quality Impact Gadgets and Report. 
- Devices considered by the Power Factor Impact Gadgets. 
- Devices considered for the Power Factor section of the Power Quality Analysis Report.  

See the configuration sections of the above features for details. 

 

To edit the inclusion and exclusion lists:  

1. Identify the System Name of the target device. Go to Management Console, 
show System Name column using the Column Selector: 
 

 

 

2. Go to SQL Server Management Studio, locate the dbo.vCFG_ConfigItems 
view in the ION_Network database, and right-click and select "Edit Top 200 
Rows". 
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The following variables are the inclusion and exclusion lists: 
 

 

3. In the Value fields, enter the comma delimited list of the devices, for 
example: 
PQ.B1,PQ.B2,Main.BackupGenerator 

4. To apply the changes immediately in the PQ Indicator Diagrams, go to the 
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PQ Advisor Setup page in Vista: 
 

 
 

Click Initialize/Update Indicators. 

 

5. To apply the changes immediately in the Power Quality Rating Gadgets, 
force the gadgets to clear their cache by “editing” the gadget, and clicking 
Save (no changes are required). 
 

To exclude all sources for a given category, put a string in the inclusion and 
exclusion list. For example: “disabled”. 

 

Change Power Quality Indicator Thresholds 
The Power Quality Indicator threshold for each indicator is displayed on the 
information page. (Click the “i” icon.) 
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The thresholds are used to determine the Power Quality Rating by using a color 
(green, orange, red) for each Power Quality indicator. Also, only the samples 
which exceed the threshold are shown in the Detail Report of the PQ Indicator 
diagrams. 

To change the thresholds:  

1. Go to SQL Server Management Studio, locate the dbo.vCFG_ConfigItems 
view in the ION_Network database, and right-click to select "Edit Top 200 
Rows". 
The following variables are the indicator thresholds: 
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The count thresholds specified here are used to determine the colors for a 
year. They get divided by 365 for Last 24 Hours, by 52 for Last 7 Days, and 
so on. The calculation is as follows: 

Round Up ( (Yearly Service Limit) x (Number of Days / 365) ) 

For example, for 30 days, where the yearly limit for orange is 5 and the 
yearly limit for red is 15: 

Orange limit:  (5 * (30/365)) = 0.41 which rounds up to 1. 
Red limit:  (15 * (30/365)) = 1.23 which rounds up to 2. 

Note: The orange limits are >=, but the red limits are >. 

Change the thresholds as needed. 

2. For the PQ Indicator Diagrams to display the updated limit information, go to 
the PQ Advisor Setting page in Vista: 
 

 
 

Click Import Indicator Limit Information. 

 

 

Disable Unused Power Quality Indicators 
When a Power Quality Indicator has no supported device to feed it the required 
data, disable it by using the procedures in the following sections. See Appendix A 
– Meter Support List on page 74 for meter support information. 

Disable Flicker, Frequency, Harmonics or Unbalance Indicators 
Use the following procedure to disable the Flicker, Frequency, Harmonics, and 
Unbalance indicators. Flicker is used specifically in this example, but the 
procedure is the same for the other items. 
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You can also use the following procedure to disable Overvoltage and 
Undervoltage. However, note that it will disable both of them simultaneously. If 
only one needs to be disabled, use the procedure in the next section.  

1. To prevent PQ Advisor from requesting Flicker values, add a string “disabled” 
to the FlickerInclusionList & FlickerExclusionList (no double quotes needed). 
See Change Device Inclusion and Exclusion for the Analysis on page 63 for 
detail steps. 

       

 
 

2. To prevent the PQ Advisor indicator diagrams from displaying status: 
a. Edit the PQADVISOR VIP in Designer. 
b. Open the Flicker folder. 

 

 

c. Add a new Ext Bool Module  . 
d. Link the switch output register of the new module to the Enable input 

register on the 4 XML import modules used for Flicker. 
i. Right click on the newly created Ext Bool Module 
ii. Change the Module Label and the switch Output Register Label to 

“Flicker Enable” 

 
 

iii. Select the outputs for the Flicker Enable module and select “Flicker 
Enable” 



Schneider Electric  Power Quality Advisor Module Configuration Guide 

Page 70 CONTROLLED DISTRIBUTION © 2016 Schneider Electric.  All rights reserved. 

 
 

iv. Select the input of the 24hr Flicker Count Import XML module and 
select “Flicker Enable” 

 
 

v. Repeat the previous step for the following: 
7d Flicker Count Import XML module 
30d Flicker Count Import XML module 
1y Flicker Count Import XML module 

vi. The result will look like this: 
 

 
 

3. Save the VIP and close Designer. 
Since the Ext Boolean has a default value of “false”, the Flicker Count Import 
modules are disabled upon saving the VIP. 

4. Check the PQ Advisor Indicator Diagram. 
The Flicker icon should be grey. 

 
 
The details should be blank: 
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Disable Sag, Swell, Interruptions, Transient or Unbalance 
Indicators 

Use the following procedure to disable the Sag, Swell, Interruptions, and 
Transient indicators, if the devices being used in the installation do not support 
them. Transients are used specifically in this example, but the procedure is the 
same for the other items. 

You can also use the following procedure to disable either Overvoltage or 
Undervoltage, if only one needs to be disabled. If both need to be disabled 
simultaneously, then use the procedure in the previous section.  

1. To PQ Advisor from requesting Transient values, add the string “disabled” 
(without the quotes) to the TransientInclusionList and  
TransientExclusionList. See Change Device Inclusion and Exclusion for the 
Analysis on page 63 for detailed steps. 

2. To prevent the PQ Advisor indicator diagrams from displaying Transient 
status: 
a. Edit the PQADVISOR VIP in Designer. 
b. Open the Sag, Swell Transient, Interruption folder. 

 

 
 

c. Right click on the 12m Event Ind Extrap module. 
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d. Double click on Formula 7 and add “S5 + “ to the beginning of the string. 
This will cause the output of the equation to be NA because S5 is 
unassigned and therefore equivalent to NA. If transients need to be 
added back to the system (e.g. a new meter which supports transients is 
purchased for the site), then it is easy to remove the string “S5 +” from 
the setup register string 
 

 
 

e. Repeat step d for Formula 8 
f. Repeat steps c, d and e for: 

24h Event Ind Extrap module 
7d Event Ind Extrap module 
30d Event Ind Extrap module 

 
3. Save the VIP and close Designer. 
4. Check the PQ Advisor Indicator Diagram. The Transient Voltage icon should 

be grey. 
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The DETAILS page should display zeros: 
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Appendix A – Meter Support List 
The meter support list provides detailed information of Power Quality Advisor 
feature dependencies on meters. Use it for both greenfield and brownfield 
designs. 

PQ Events 
and 

Disturbances 
Used by Supported Meters Supported 

Meter Template 

Interruptions 

PQ Advisor Diagrams 
PQ Rating Gadget 
PQ Rating Trend Gadget 
PQ Events Breakdown 
Gadget 
PQ Events Impact Gadget 
PQ Events Location Gadget 
PQ Analysis Report 
PQ Impact Gadget 
PQ Impact Trend Gadget 
PQ Impact Report 

ION 7350, 7550, 7650, 8600A, 8600B, 8650A, 8650B, 8650C, 
8800A, 8800B, 8800C, PM8000, PM870, CM3350, CM4000 
 
DDD Support: ION7550 V350 and newer, ION7650 V350 and 
newer, ION8650A/B V4.20 and newer, PM8000, CM4000 

All default meter 
template 

Voltage Sag Same as Interruptions Same as Interruptions All default meter 
template 

Voltage Swell Same as Interruptions Same as Interruptions All default meter 
template 

Transient 
Voltage 

Same as Interruptions ION 7650, 8600A, 8650A, 8650B, 8800A, CM4000T 
 
DDD Support: ION7650 V350 and newer, ION8650A/B V4.20 and 
newer, CM4000T 

All default meter 
template 

Over Voltage 
Same as Interruptions ION 7350, 7550, 7650, 8600A, 8600B, 8650A, 8650B, 8650C, 

8800A, 8800B, 8800C, PM8000 
All default meter 
template 

Under 
Voltage 

Same as Interruptions ION 7350, 7550, 7650, 8600A, 8600B, 8650A, 8650B, 8650C, 
8800A, 8800B, 8800C, PM8000 

All default meter 
template 

Voltage 
Unbalance 

PQ Advisor Diagrams 
PQ Rating Gadget 
PQ Rating Trend Gadget 
PQ Analysis Report 

Logged By Default: ION 7330, 7350, 7550, 7650, 8600A, 8600B, 
8650A, 8650B,  8800A, 8800B, PM8000, CM3000, CM4000, 
TesysT, Micrologic 5.0/6.0/7.0 E/P/H (including IFE/IFM) 
Not Logged By Default: PM8001, PM3250, PM3255, PM5100, 
PM5300, PM5350, PM5500, EM6400, EM7000, Micrologic 
5.2/6.2/5.3/6.3 E 

All default meter 
template 

Current 
Unbalance 

PQ Advisor Diagrams 
PQ Rating Gadget 
PQ Rating Trend Gadget 
PQ Analysis Report 

Logged By Default: TesysT, Micrologic 5.0/6.0/7.0 E/P/H 
(including IFE/IFM) 
Not Logged By Default: PM8001, CM3000, CM4000, PM3250, 
PM3255, PM5100, PM5300, PM5350, PM5500, EM6400, 
EM7000, Micrologic 5.2/6.2/5.3/6.3 A/E 
 

n/a 

Voltage 
Harmonics 

PQ Advisor Diagrams 
PQ Rating Gadget 
PQ Rating Trend Gadget 
PQ Analysis Report 

Logged By Default: ION 7330, 7350, 7550, 7650, 8600A, 8600B, 
8650A, 8650B, 8800A, 8800B, PM8000, CM3000, CM4000 
Not Logged By Default: ION 6200, 7300, 8600C, 8650C, 8800C, 
PM200, PM700, PM8001, PM1200, PM3250, PM3255, PM5100, 
PM5300, PM5350, PM5500, EM3460, EM6400, EM7000, 
Micrologic 5.2/6.2/5.3/6.3 E, Micrologic 5.0/6.0/7.0 H (including 
IFE/IFM) 
 

All default meter 
template except 
PM8000 with 
IEEE 519 
template 
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Current 
Harmonics 

PQ Advisor Diagrams 
PQ Analysis Report 

Logged By Default: ION 7330, 7350, 7550, 7650, 8600A, 8600B, 
8650A, 8650B, 8800A, 8800B, PM8000, CM3000, CM4000 
Not Logged By Default: ION 6200, 7300, 8600C, 8650C, 8800C, 
PM200, PM700, PM8001, PM1200, PM3250, PM3255, PM5100, 
PM5300, PM5350, PM5500, EM3460, EM6400, EM7000, 
Micrologic 5.2/6.2/5.3/6.3 E, Micrologic 5.0/6.0/7.0 H (including 
IFE/IFM) 

All default meter 
template except 
PM8000 with 
IEEE 519 
template 

Frequency 
Variation 

PQ Advisor Diagrams 
PQ Rating Gadget 
PQ Rating Trend Gadget 
PQ Analysis Report 

Logged By Default: ION 7330, 7350, 7550, 7650, 8600A, 8600B, 
8650A, 8650B,  8800A, 8800B, PM8000 

All default meter 
template 

Flicker 

PQ Advisor Diagrams 
PQ Rating Gadget 
PQ Rating Trend Gadget 
PQ Analysis Report 

Logged By Default: ION 7650, 8600A, 8650A, 8800A, 8800B PQ Framework 
and EN50160 
evaluation 
enabled 

 

Note: 
1 PM800 series is supported except PM810 without PM810LOG. 

 

Detailed information specifically for Power Factor: 

Power Factor 

Used by Supported Meters 

Power Factor Impact Gadget 
Power Factor Impact Trend Gadget 

All meters that have measurements required by the 
calculation of the defined rate structure. 
For example: 

• Active energy 
• Reactive energy 
• Active power 
• Reactive power 

PQ Analysis Report All meters that measures active energy, reactive 
energy, and power factor 
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Appendix B – Measurement Support List 
The measurement support list provides detailed information about the supported 
measurements that are compatible with the Power Quality Advisor module. 

Note: For each disturbance category, choose only the appropriate/necessary 
measurements from the supported list to log. Do NOT Log all of them. Not doing so can 
cause unwanted database growth, and performance issues. 

 

PQ 
Disturbances Used by Supported Measurements Label Name 

Voltage 
Unbalance 

PQ Advisor Diagrams 
PQ Rating Gadget 
PQ Rating Trend 
Gadget 
PQ Analysis Report 

ION Devices 
Voltage Unbalance Mean  

V unbal mean 

Non-ION Devices 
Voltage Unbalance L-L Worst 
Voltage Unbalance L-N Worst 

Voltage Unbalance L-L 
Worst 
Voltage Unbalance L-N 
Worst 

Current 
Unbalance 

PQ Advisor Diagrams 
PQ Rating Gadget 
PQ Rating Trend 
Gadget 
PQ Analysis Report 

Non-ION Devices 
Current Unbalance Worst 

Current Unbalance Worst 

Voltage 
Harmonics 

PQ Advisor Diagrams 
PQ Rating Gadget 
PQ Rating Trend 
Gadget 
PQ Analysis Report 

ION Devices 
Voltage Total Harmonic Distortion on Input V11 
Voltage Total Harmonic Distortion on Input V21 
Voltage Total Harmonic Distortion on Input V31 
Voltage Total Harmonic Distortion Mean on Input 
V1 
Voltage Total Harmonic Distortion Mean on Input 
V1 
Voltage Total Harmonic Distortion Mean on Input 
V1 

V1 Total HD1 
V2 Total HD1 
V3 Total HD1 
V1 THD mean 
V2 THD mean 
V3 THD mean 

Non-ION Devices 
THD Voltage A-B 
THD Voltage A-N 
THD Voltage B-C 
THD Voltage B-N 
THD Voltage C-A 
THD Voltage C-N 
THD Voltage L-L 
THD Voltage L-N 

THD Voltage A-B 
THD Voltage A-N 
THD Voltage B-C 
THD Voltage B-N 
THD Voltage C-A 
THD Voltage C-N 
THD Voltage L-L 
THD Voltage L-N 

Current 
Harmonics 

PQ Advisor Diagrams 
PQ Analysis Report 

ION Devices 
Current Total Harmonic Distortion Phase A1 
Current Total Harmonic Distortion Phase B1 
Current Total Harmonic Distortion Phase C1 
Current Total Harmonic Distortion Phase A Mean 
Current Total Harmonic Distortion Phase B Mean 
Current Total Harmonic Distortion Phase C Mean 

I1 Total HD1 
I2 Total HD1 
I3 Total HD1 
I1 THD mean 
I2 THD mean 
I3 THD mean 
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Non-ION Devices 
Current Total Harmonic Distortion Phase A 
Current Total Harmonic Distortion Phase B 
Current Total Harmonic Distortion Phase C 

THD Current A 
THD Current B 
THD Current C 

Frequency 
Variation 

PQ Advisor Diagrams 
PQ Rating Gadget 
PQ Rating Trend 
Gadget 
PQ Analysis Report 

ION Devices 
Frequency Mean 

Freq mean 

Flicker 

PQ Advisor Diagrams 
PQ Rating Gadget 
PQ Rating Trend 
Gadget 
PQ Analysis Report 

ION Devices 
Voltage Flicker Plt on Input V1 
Voltage Flicker Plt on Input V2 
Voltage Flicker Plt on Input V3 
Voltage Flicker Pst on Input V1 
Voltage Flicker Pst on Input V2 
Voltage Flicker Pst on Input V3 

V1-Flck Plt 
V2-Flck Plt 
V3-Flck Plt 
V1-Flck Pst 
V2-Flck Pst 
V3-Flck Pst 

 

Notes: 

PM8000 is categorized as an ION device.  

ION6200 is categorized as a non-ION device. 
1 Use only for ION 6200, 7300, 8600C, 8650C and 8800C. These measurements are NOT 
logged by default. 
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Appendix C – Power Factor Rate File Calculation 
This appendix explains the power factor calculations in the default rate files. To 
learn how to modify the rate files, please refer to the PME Billing Module Toolkit: 
https://exchangecommunity.schneider-electric.com/docs/DOC-8707 

Power Factor Impact – Active Energy Billing with PF Adjustment Option 1 

The utility charges according to the active energy and adds a surcharge or 
adjustment for power factor. 

 

 

 

Power Factor Impact – Active Energy Billing with PF Adjustment Option 2 

The utility charges according to the active energy and adds a surcharge or 
adjustment for power factor. 

 

 

 

Power Factor Impact – Apparent Energy Billing.xml 

The utility bills all consumed energy, including the reactive energy. 

 

 

Power Factor Impact – Reactive Energy Billing.xml 

 

 

https://exchangecommunity.schneider-electric.com/docs/DOC-8707
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